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INTRODUCTION  

This is the SWISSTRAFFIC.ai Viewer User Guide which is part of SWISSTRAFFIC.ai Software Suite.  

SWISSTRAFFIC.ai Viewer is unique software for further analysis, advanced interpretation and 

visualization of traffic data, capable of measuring macroscopic flow characteristics at any point or 

region required by analyzing all trajectories in that place. Discover anything you want from your 

trajectory data.  

This user guide is for DRONE and SCOUT mode of this program.  

DRONE mode is designed for video recording from a higher height, e.g. a drone above a roundabout at 

150 meters. This means that the objects are smaller, and the viewing angle is larger. It is supposed to 

use georegistered data, i.e. the connection of the scene with the map. In this mode of viewer there are 

real units used (meters, feet, ...).  

How to record the video for SWISSTRAFFIC.AI DRONE 

SCOUT mode of viewer is designed for scenes shot from a smaller height, such as traffic cameras. 

Objects are much larger, it is not georegistered data i.e. individual trajectory positions are only in the 

image (expressed in pixels).  

How to record the video for SWISSTRAFFIC.AI SCOUT 

The application is currently in rapid development phase. We are working hard to improve the 

functionality and usability of the application to satisfy the needs of its users. If you encounter any 

application crash or unexpected behaviour, please, do not hesitate to contact us on 

info@SWISSTRAFFIC.ai 

 

If you want to try SWISSTRAFFIC.ai Viewer, you can download it at this link.   

 

Under this link you will be able to download any updates, which we always inform about on our 

website www.SWISSTRAFFIC.ai/news 

If you have any questions or want help with something specific, please use our Help Desk & FAQ.   

mailto:info@SWISSTRAFFIC.ai
https://www.swisstraffic.com/en/assets/downloads/swisstraffic_ai/viewer/viewer.exe
https://www.swisstraffic.com/en/content/ai/help-center
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OVERVIEW   

SWISSTRAFFIC.ai Viewer provides means to view, create, browse, inspect and edit vehicle tracking 

data in video sequences. The main functionality of the application is following: 

• Inspect an existing Tracking Log files along with analyzed video sequences 

• Export vehicle tracking data to CSV or Excel data files suitable for further analysis 

• Add Overlay with velocity or acceleration visualization 

• Export Visualization Video or Visualization Snapshot 

• Visualization of annotated or detected vehicle Trajectories 

• Create an Origin-Destination statistics and Flow Graphs 

Available only in SCOUT mode: 

• Display colours of vehicles in the flag 

Available only in DRONE mode: 

• Georegistered data 

• Make Gap time and Time to Follow analysis 

• Safety analysis (Time To Collision, Post Encroachment Time, Heavy Breaking) 

• Export Trajectories to CSV 

• Projection Offset Fix 

• Calculate Headway Statistics 

Attention! 

Because in SCOUT mode of Viewer there are not georegistered data, actual velocity is expressed in 

thousands of pixels per hour (kilo-pixels - Kpx/h) and acceleration is in pxs-2. 
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BASIC CONCEPTS AND TERMINOLOGY  

The Viewer is an application that ties together the image data (video), annotation and trajectories of the 

tracked objects. A tracked vehicle can be understood either as an object having an immediate position 

at any time, or as a complete trajectory in time-space. Therefore, some information available via the 

Viewer is time-dependent where the user can set the viewing time, and some of the information is time-

independent. 

The items that form annotation of the scene are these: 

• Gates – Virtual lines that register crossing vehicles, can be directional and selective according to 

object classification, can be designated as Entry, Exit and Other. 

• Lanes – Areas within which vehicles are expected, can be designated as Entry, Exit and Other. 

• Traffic Region – Regions used to define a Stationary vehicle and Stationary Time. 

• Action Region – Regions used to detect the Presence and Speeding of objects. 

• Anonymization Region – Regions used to anonymize a certain area in the scene view. 

Available only in DRONE mode:  

• Analysis nodes – Virtual objects that relate other annotations to each other.  

 

TRACKING LOG  

Tracking Log represents a data package containing information about traffic analysis scene and detected 

or annotated vehicle trajectory data. Tracking Log is stored in Tracking Log files (suffix “.tlg”). Each 

Tracking Log is closely tied to the video sequence file, as it itself does not contain image data. If you want 

to view or edit Tracking Log in SWISSTRAFFIC.ai Viewer, you have to provide original video sequence file 

as well. 

 

USER INTERFACE  

The application can be started by running executable file SWISSTRAFFIC.ai Viewer.exe. Upon the start 

of the application, welcome screen is shown. For more information about running the program, see 

the Welcome Screen - Running the Program section of the guide. 
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HELP MENU 

The application offers classic Windows User Interface operable with mouse and keyboard. User Guide 

for the application can be invoked by selecting the Help item located at the top bar of the program or 

by pressing F1. In the Help menu you can also find information About SWISSTRAFFIC.ai Viewer. Here 

are the data about application version or build number. In this menu you will also find information 

about User License. 

 

Figure 1: Help section 

 

  

About SWISSTRAFFIC.ai Viewer 
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WELCOME SCREEN - RUNNING THE PROGRAM 

First you need to download the program from the following link: 

https://www.swisstraffic.com/en/assets/downloads/swisstraffic_ai/viewer/Viewer.exe 

 

After downloading the program, run the installation file SWISSTRAFFIC.ai Viewer. Here you can choose 

where you want to install the program. 

 

Figure 2: SWISSTRAFFIC.ai installation 

 

After installation open the SWISSTRAFFIC.AI Viewer folder and click SWISSTRAFFIC.ai Viewer to start 

the program. 

  

Figure 3: SWISSTRAFFIC.ai Viewer 

 

The SWISSTRAFFIC.ai Viewer Welcome Screen appears. 

 

Figure 4: SWISSTRAFFIC.ai Viewer Welcome Screen 

 

https://www.swisstraffic.com/en/assets/downloads/swisstraffic_ai/viewer/Viewer.exe
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SCENE VIEW 

Once the application holds a valid tracking log, the main area is switched to Scene View which is 

depicted in following image. 

Figure 5: Scene view 

 

The main part of Scene View is a video sequence with attached Annotations. At the top of the screen is 

Main toolbar. On the Top bar you can see the current mode of viewer. A player-like slider for video 

playback is available at the bottom of main window. List of all the Trajectories contained in the video 

sequence, is placed in the right side of the Viewer. 

You can use the Mouse wheel to zoom in or out of the main image or you can set the desired zoom on 

the Main bar. To move the image, click and drag the mouse wheel. 

 

Figure 6: Zoom Setting 

 

  



 

                                                                     V 1.0 / September 2020                                                                    11/99 

TRAJECTORIES 

The Trajectory line represents the path of the tracked object, it is double coloured, green colour 

represents already travelled part of trajectory and blue colour represents the part of trajectory that is 

to be travelled.  

 

Figure 7: Trajectory line 

 

List of all the Trajectories contained in the video sequence, is placed in the right side of the Viewer, in 

the box called Trajectories. 

 

Figure 8: Trajectories 
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Scene View and right column are synchronized. Clicking on a tracked vehicle's Track Flags or selecting 

Trajectory in Trajectories list will highlight the marked Track and displays the following information in 

the Selected Trajectory list: 

 

Figure 9: Selected Trajectory 

 

Track ID – Unique identification number of each object. 

Vehicle Type – Object classification, there are 7 object 

categories: Car, Medium Vehicle, Heavy Vehicle, Bus, 

Motorcycle, Bicycle, Pedestrian and Undefined. 

Vehicle Colour – Only in SCOUT mode. Shows the 

estimated color of the vehicle (not for pedestrians). 

Current Speed – Absolute size of object velocity vector. In 

DRONE mode of viewer is expressed in Kilometres per hour 

or miles per hour. In SCOUT expressed in kilo-pixels - Kpx/h. 

Tangential Acceleration – Only in DRONE mode. Current 

Tangential Acceleration of the vehicle expressed in metres 

per squared second (ms-2). Positive value means 

acceleration and negative value means deceleration. 

Lateral Acceleration – Only in DRONE mode. Current lateral 

(normal) acceleration of the vehicle expressed in metres 

per squared second(ms-2). Positive value means 

acceleration to the right and negative value means 

acceleration to the left. 

Total Acceleration – Absolute size of immediate acceleration vector. 

 

Figure 10: Selected Trajectory list 
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Average Speed in Crossroad – Average vehicle speed in crossroad area (between Entry and Exit Traffic 

Analysis Gates). 

Time in crossroad – The time the object spent at the crossroad (between Entry and Exit Traffic Analysis 

Gates), expressed in seconds. 

First image ID – Index of the image from beginning of the video sequence where the Track starts in. 

The Go to! button allows fast navigation to that moment. 

Last image ID – Index of the last image where the displayed track ends. The Go to! button allows fast 

navigation to that moment. 

Entry gate ID – Unique identification number of the Entry Traffic Analysis Gates the vehicle crossed 

when entering crossroad area. 

Exit gate ID – Unique identification number of the Exit Traffic Analysis Gates the vehicle crossed when 

exiting crossroad area. 

Movement dynamics – Displays a graph of speed and acceleration for each trajectory. Clicking the 

Show button will show you the Speed and Accelerations graph. 

 

Speed and Accelerations graph 

This graph shows the course of speed and acceleration of the tracked object. 

At the bottom of the graph, you can choose whether you want the graph to show relative to the 

Video time or the Travelled distance of the object. On the left axis is the Vehicle Speed scale, the 

green line. The right axis is the Accelerations scale, the blue line for Total acceleration, orange for 

Lateral acceleration and purple for Tangential acceleration. Red and Green line in graph represents 

the moment when the vehicle crossed the Entry or Exit Traffic Analysis Gates. 

Select Trajectory – By clicking the Select Trajectory button you can highlight the trajectory in the 

scene view. 
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Figure 11: Speed and Acceleration graph 

 

By double-clicking on the graph field, you can jump to a moment of the video sequence in the Scene 

View

 

Figure 12: Speed and Acceleration graph 

 

  



 

                                                                     V 1.0 / September 2020                                                                    15/99 

TRAFFIC ANALYSIS GATES 

Gates are virtual lines that register crossing vehicles, can be directional and selective according to 

object classification. They are divided by their designated role for analysis into Entry, Exit and Neutral. 

They are used to generate a Origin-Destination , Export Gap-Time/Time-to-Follow Data and to Export 

Gate Crossing Events to CSV File. Learn more about Manage Annotation Configurations - Editing 

Annotation, Show Traffic Gates and inserting Gates.  

As before with Trajectories, clicking a Gate in the scene brings it up in the Traffic Analysis Gates list.

 

Figure 13: Traffic Analysis Gates list 

 

If you click on the Gate you will see a table of all related information. 

• Gate Unique ID – Each Gate has its own unique ID. 

• Gate Tag – Lists the name of each Gate. 

• Passed Vehicles (Count) – The number of vehicles 

that have passed through the Gate during the 

whole video sequence. 

• Vehicle Flow (per 15min) – Recalculated flow of 

vehicles for 15 minutes. 

• Avg. Speed [Km/h] – The average speed of the 

vehicle passing through the Gate. (In SCOUT mode 

expressed in thousand pixels per hour – Kpx/h) 

• Detailed Info 

 

 

 

 
Figure 14: Traffic Analysis Gates 
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Detailed Info 

If you click on Show Detailed Info you will see a table containing information about all the objects that 

passed through the Gate. In the Types field, you can check which types of objects you want to display. 

If you double-click a track row in the table, a track appears in the scene view. You can Export this table 

in .csv format for later analysis.  

 

Figure 15: Gate Info 
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Calculate Headway – Only in DRONE mode.  

Headway is a key input in calculating the overall route capacity of any transit system. It is the distance 

from the tip of the vehicle that passed through the given point (Gate) to the tail of the vehicle that 

passed before it. 

• Headway [s] – The amount of Time between tip of one vehicle to tail of the next one passing 

through a given point (Gate) in transportation systems.  

• Headway [m] – The Distance from the tail of one vehicle to the tip of the next one behind it.  

 

Figure 16: Headway 
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SHOW POSITION AND ADD LABEL 

If you right-click in the scene view area a menu appears, here you can add a Show position marker or 

Add label. 

 

Figure 17: Show position, Add label 

 

Show position 

If you select a Show position option, a blue marker showing the position of that point appears, left-

click and drag to move the marker over the image. If you insert multiple markers, lines appear 

between them to indicate the distance between these points. In SCOUT mode of Viewer is the 

distance in pixels. Right-click on a marker and select Hide position to remove the marker. In Units 

Settings you can change the coordinate system from UTM to WGS 84, only in DRONE mode. 

 

Figure 18: Show position 
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Add label 

If you select a Add label option a Add label window appears. Here you can type the text you want. 

Left-click and drag to move the label over the image. If you right-click on a label, a menu appears, here 

you can Edit or Remove the label.  

 

Figure 19: Add label window 

 

Target Distance 

This setting allows you to display the distance between individual vehicles, right-click on the vehicle or 

Track Flags to select this option. 

 

Figure 20: Target Distance 

 

Show Target Distances – If you right-click on a vehicle and select this option you will see the distance 

of other objects from that vehicle. 

Set Max Target Distance Radius – Sets the size of the circle at which distances from other objects will 

be displayed. 

Show Max Target Distance Radius – Shows circle in which the distances from other objects are 

displayed. If you want to hide this circle, right click on the vehicle and select Hide Max Target Distance 

Radius. 
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Figure 21: Show Target Distances and Show Max Target Distance Radius 
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FILE MENU 

The File menu is used to control the basic functions of the program: 

• Open Tracking log 

• Import Input Video 

• Save Tracking log 

• Export Tracking Log 

• Export Traffic Survey Video 

• Export Traffic Survey Snapshot 

• Export Trajectories to CSV File 

• Change Application License 

 

 

  

 

Figure 22: File Menu 
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Open Tracking log 

To open the tracking log, you can directly open the .tlgx file in your computer or you can drag and drop 

the .tlgx file into an already running viewer. You can also use the Open Tracking Log button directly on 

the Main Toolbar.  

 

Figure 23: Open Tracking Log button 

 

Or you can use the File Menu and click Open Tracking Log. 

 

Figure 24: Open tracking log 

 

In both cases, the Open Tracking Log window appears, then locate the .tlgx file you want to work with 

and open it. Reading of the tracking log and initializing the display are two steps that can take longer 

and display a progress bar. 

 

Figure 25: .tlgx file 



 

                                                                     V 1.0 / September 2020                                                                    23/99 

When you open a valid tracking log, the main area switches to the scene view shown in the following 

figure. 

 

Figure 26: Tracking log 

 

Import Input Video 

After selecting Import Input Video, a window will open where you can find the desired video file. 

Importing another video will not affect existing Trajectories. 
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Save Tracking log 

If you want to Save Tracking Log you can save it by clicking the Save Tracking Log button. 

 

Figure 27: Save Tracking Log button 

 

Or you can use the File Menu and click Save Tracking Log… 

 

Figure 28: Save Tracking Log... 

 

In both cases, the Save tracking log window appears, here you can select the file name and where you 

want to save it. 

 

Figure 29: Save Tracking Log 
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Change Application License 

Last field of File Menu is Change Application Licence, here you can Activate the application or Register 

for a free evaluation licence.  

 

Figure 30: Save Tracking Log 

 

To activate the application, the license has to be invoked. Please, fill in your license ID in the following 

field. License ID has been sent to you by an e-mail used in registration form or has been provided to 

you as part of a commercial licence. 

If you have not obtained any licence ID, you can do so by registering this copy of the application to 

obtain free evaluation licence. Just click Register button bellow. 

If you have lost your licence ID or have any other difficulties, please contact our support on web 

address: http://SWISSTRAFFIC.ai/contact-us 

 

Figure 31: Save Tracking Log 

http://SWISSTRAFFIC.ai.com/contact-us 
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TRACKING LOG MENU 

You can find in this menu: 

• Tracking Log Settings 

• Manage Annotation Configurations - Editing Annotation 

• Fix Offset Error 

• Tracking log Information 

• Tracking Log Statistics 

 

Figure 32: Tracking Log Menu 

 

TRACKING LOG SETTINGS 

Only in DRONE mode. Here you can set Coordinate System for georegistered log. You can change UTM 

zone and Hemisphere.  

Bounding Box Settings – Sets whether a Vehicle 

Position Pivot (red dot on every object) is at the 

Top or Bottom of the Bounding Box. 

 

 

  

 
 Figure 33: Tracking Log Settings 
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MANAGE ANNOTATION CONFIGURATIONS - EDITING ANNOTATION 

Select the Tracking log menu and click on Manage Annotation Configurations if you want to add: 

• Gates 

• Lanes 

• Anonymization Region 

Anonymize everything outside current 

view 
Clicking this option will anonymize 

everything except current view. Since 

Annotations are defined in Work Space 

(see Switch Coordinate Space) when you 

check the Anonymize everything outside 

current view option, it looks all the same in Workspace, but if you switch to Reference / Raw space, 

parts of the image that are not in the Workspace are then blurred. 

To simplify the procedure: 

• Open tracking log. 

• Switch view to Workspace. 

• Open Manage annotation configuration. 

• Set the view you want to anonymize. 

• Click Anonymize everything outside current view. 

• Confirm. 

• Then switch to Raw / Reference space and anonymous parts should be visible. The Show 

Anonymization regions must be checked. 

 

Figure 49: Anonymize everything outside current view button 

 

  

 

Figure 34: Manage Annotation Configurations 
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• Action Region 

• Traffic Region 

• Measurement Node 

 

 

 

 

 

 

You will see the Annotation Configuration Manager. Original annotation configuration is pre-set and 

cannot be edited, so click on the Clone button. 

 

Figure 35: Annotation Configuration Manager, Clone 
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You have created a clone of the Original Annotation Configuration which can be edited, so click on the 

Active field and then click on the Edit button. 

 

Figure 36: Annotation Configuration Manager, Edit 

 

Then Annotation Redefinition opens, this editor allows you to insert and edit Annotations. To zoom in 

or out of the main image you can use the mouse wheel, click on the mouse wheel and drag to scroll 

the image. The key concepts are the following:  

• The annotations visible in scene itself are Gates, Traffic Regions and Action Regions.  

• The selected annotation is highlight in the Annotation Object List on the right side of the 

window, and its properties can be edited directly above. 

• It is possible to define virtual Traffic Measurement Nodes (available in DRONE mode only) 

which connect various other annotations. These have their own editor on the right bottom 

side.  

 

Figure 37: Annotation Redefinition 
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After setting all required Annotations confirm Editing by clicking the Confirm Annotation Redefinition 

button located on the bottom of the editor, you can also Reset the settings to Initial state or Cancel 

Annotation Redefinition. 

 

Figure 38: Reset, Confirm or Cancel Annotation Redefinition 

 

The editor window closes and then click on the Apply button. 

 

Figure 39: Apply button 

 

Gates 

The first button on the Main Toolbar is used for adding Gates. Gates are virtual lines which are crossed 

by vehicles and other tracked objects. They are in the form of a line consisting of straight segments 

connecting points, so you need at least 2 points to create them. To create a Gate, click on the button 

Add Gate or right-click in the scene view and select Add Gate. Then create at least two points 

between which you want to create a Gate, you can move the created point by clicking and dragging 

the mouse. Point can be removed by right-clicking and selecting Remove Control Point.  

 

Figure 40: Create a Gate 

 

Then you can set the desired properties of the created Gate in the right column Selected Annotation.  
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• Gate Type – Set whether the Gate is Entry, Exit, 

or Neutral 

• Gate Direction – Sets the direction in which 

passing objects are to be tracked by the Gate.  

• Object detection mode – Sets the method by 

which the object is to be detected, whether it 

will be based on Trajectory or on Visual 

Detector.  

• Object detection range – If you select Visual 

Detector, you can set the size of the detection 

range. 

• Angular Sensitivity – Adjusts the sensitivity of 

the Gate depending on the angle of the passing 

object. 

• Allowed Objects – After clicking on this menu you can choose what kind of object the Gate will 

count. (Undefined, Car, Medium Vehicle, Heavy Vehicle, ...) 

• Allowed Colours – Only in SCOUT mode. Sets which object colours the Gate will count. 

• Tag – This field is used to set the Gate name. 

After setting the desired properties, confirm the Gate settings with the Finish Editing button. 

 

Figure 42: Finish Editing 

 

If you want to modify the properties of the created Gate or move it, click it with the left mouse button, 

then you can change its settings in the Selected Annotation column, you can also move it by clicking 

and dragging with the left mouse button. If you want to change the location of the Control Points of 

the Gate, click on the Gate and then in the upper bar click Edit Annotation button, then you can 

change the position or number of points of the Gate. If you want to Delete whole Gate click Delete 

Annotation button. Or you can right-click on the Gate to select the desired option. 

 
Figure 41: Example of annotation settings 
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Figure 43: Edit Annotation 

 

After making the desired adjustments, press Finish Editing button to confirm. 

 

Figure 44: Finish Editing 

 

For example, a roundabout with Entry and Exit Gates. 
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Figure 45: Roundabout with Entry and Exit Gates 

 

Lanes 

Lanes are areas where vehicles can be present. Their insertion is similar to the Gates and have the 

same colour coding Entry, Exit and Neutral. A Lane is drawn by pressing the Add Lane button, then 

clicking the points which form a polygonal border of the lane. The polygon is always closed, it is 

possible to display it only after three points are added. A Lane should cover the whole area, erring on 

the side of spreading out rather than shrinking. Ideally, a small overlapping of lanes is made, so that 

there is no space between lanes. Already placed points can be moved by dragging and removed by 

right click and select Remove Control Point. In right column you can also set Lane Type and Tag, 

setting is similar to Gates. Creating the Lane is done by pressing the Finish Editing button in Main 

Toolbar. You can also Edit or Delete Lanes by clicking Edit or Delete button on Main Toolbar.  
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Figure 46: Add Lane 

For example, a roundabout with Lanes and Gates. 

 

Figure 47: Roundabout with Lanes and Gates 

 

Anonymization Region  

Anonymization Region is used to anonymize a certain area in the scene view, it is inserted in the same 

way as the Lanes, you can set Degree of blur in the Selected Annotation column. More settings of 

anonymization regions Show Anonymization regions, Keep Anonymization regions up to date. 
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Figure 48: Anonymization Region 

Anonymize everything outside current view 

Clicking this option will anonymize everything except current view. Since Annotations are defined in 

Work Space (see Switch Coordinate Space) when you check the Anonymize everything outside current 

view option, it looks all the same in Workspace, but if you switch to Reference / Raw space, parts of 

the image that are not in the Workspace are then blurred. 

To simplify the procedure: 

• Open tracking log. 

• Switch view to Workspace. 

• Open Manage annotation configuration. 

• Set the view you want to anonymize. 

• Click Anonymize everything outside current view. 

• Confirm. 

• Then switch to Raw / Reference space and anonymous parts should be visible. The Show 

Anonymization regions must be checked. 

 

Figure 49: Anonymize everything outside current view button 
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Action Region 

Action Regions are used to detect the Presence and Speeding of objects in a certain area of the scene 

view. To create an Action Region, click on the button Add Action Region or right-click in the scene 

view and select Add Action Region. It is inserted in the same way as the Lanes. 

 

Figure 50: Add Action Region 

 

In the Selected Annotation settings, you can find:  

Annotation Type – The currently Selected Annotation Type. 

Region ID – ID Annotation number. 

Presence Alert – Enable the Object Presence Alert. You can 

then Select Object Types for which the Presence Alert will 

be displayed. If the desired type of object enters the Action 

Region an Alert is displayed and the Action Region where 

the event occurred is highlighted. 

Speeding Alert – If the vehicle exceeds the set speed, an Speeding Alert is displayed in the scene view, 

the Action Region where the event occurred is highlighted and how much the maximum speed has 

been exceeded is displayed in the Flag above the object. 

• Select Max. Speeds – Here you can set maximum speeds for individual objects. 

• Select Object Colours – Only in SCOUT mode. Here you can set for which object colours the 

Alert will be displayed. 

 

Figure 52: Action Region Settings 

 
Figure 51: Presence and Speeding Alert 
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Traffic Region 

Traffic Region work in a similar way to the Gates, but it is inserted in the same way as the Lanes. It is 

used to defining a stationary vehicle in a certain area in the scene view. Some vehicles that wait at the 

intersection do not stop completely but commute very slowly. Then they are not considered as 

stationary. If you want to Show Traffic Regions in the scene view you can use the button on the Main 

Toolbar.  

In the Selected Annotation settings, you can find:  

Annotation Type – The currently selected annotation type. 

Region ID –ID Annotation number. 

Tag – You can edit the Traffic Region name here. 

Allowed Types – Here you can set which kinds of objects the Traffic Region will detect. 

Allowed Colours – Only in SCOUT mode. Here you can set which object colours the Traffic Region will 

detect. 

Max. Stationary Vehicle Speed – Sets the maximum speed at which the vehicle is considered 

stationary. 

Min. Stationary Vehicle Spell – Sets how long at least the vehicle must be below Max. Stationary 

Vehicle Speed to be considered stationary. 

 

Figure 53: Traffic Region  

 

  



 

                                                                     V 1.0 / September 2020                                                                    38/99 

Measurement Node – Gap Time and Time to Follow 

Available in DRONE mode only. Measurement Nodes are used for calculation Gap Time and Time to 

Follow data, it is used to assess the capacity of a crossroad. 

• Gap time (Tg) – Represents critical time gap between two successive cars in the main (major) 

lane that decides whether a car from the minor lane can enter/join the crossroad and fit into 

the gap. If the time difference between two successive cars is bigger than this critical value, 

then the waiting car on the minor lane (on average) enters the crossroad. If the difference is 

smaller than this critical value, the waiting car (on average) does not enter the crossroad. 

• Time to Follow (Tf) – Represents the average time difference between two successive cars in 

the minor lane that enters the crossroad after a waiting. This time is measured at the entrance 

to the crossroad. 

These values can be used to better estimate the actual capacity of given crossroad. Current 

approaches assume the general approximation of these values based on tabled values based on 

crossroad type and some of its geometry parameters. These may however be inaccurate/incorrect due 

to various other factors (field of view, road surface, signs, etc…). Thus, the data acquired by 

SWISSTRAFFIC.ai can be used to retrieve a better estimation based on traffic flow and driver’s 

behaviour in the exact case. 

To be able to export the post-process information, the following requirements have to be met: 

• The traffic scene has to be properly annotated (see item Manage Annotation Configurations - 

Editing Annotation in Tracking Log Menu): 

• Every entry point to the crossroad that we would like to analyse should be additionally 

annotated by Traffic Measurement Node. Traffic Measurement Node consist of Waiting Gate 

– Lane pair and non-empty list of Blocking Gate – Lane pairs. 

• The Waiting Gate should be placed at the Entry of minor lane to the major lane. The waiting 

cars should all pass through this Waiting Gate when they enter the crossroad.  

• The Waiting Lane is a lane where the waiting cars (that are waiting for major lane to be empty 

enough to enter the road) will be waiting. This should cover all the surface of road where these 

cars may be waiting. 

• The Blocking Lane is the surface of the main Lane. If there are multiple main Lanes, all should 

be annotated separately and be part of blocking Gate-Lane pairs. For each Blocking Lane, there 

should be its pairing Blocking Gate. 

• Blocking Gate is a Gate at which the blocking events will be detected. These are to assess the 

Gap time (Tg) and to detect the congestion of the main lane. 

• The traffic must be congested enough for waiting of vehicles at the waiting lanes to happen. If 

there are no waiting vehicles, the application cannot estimate Tg and Tf values. 
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First, we must properly annotate the Traffic Scene. In the example in the following figure the Waiting 

Pairs are Gate 14 and Lane 15 and the Blocking Pairs are Gate 16 and Lane 17. 

 

Figure 54: Measurement Node – example 

 

Next, we have to set Blocking and Waiting Pairs with Measurement Node. We do this by clicking on 

the Add Node button, which can be found at the bottom of the right column. Then you need to specify 

Blocking and Waiting Pairs. You can do this by clicking the pick button and selecting the appropriate 

annotation. You can also Remove Node or Blocking Pair. 

 

Figure 55: Add Node  

 

If the traffic scene is properly annotated, we can proceed to Export Gap-Time/Time-to-Follow Data.  
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FIX OFFSET ERROR 

Available only for DRONE mode. It is used to correct a projection error or to shift trajectories. 

 

Figure 56: Tracking Log Menu 

 

Projection Offset Fix 

Available only for DRONE mode. It is used to correct a projection error, for example, if the trajectories 

in the image are on the hood of the vehicle, this function moves the trajectories to the ground 

according to the specified object heights. If you want to make this correction only for a single 

trajectory, mark it first in the scene view. 

 

Figure 57: Projection Offset Fix window 

 

Parametrical Offset Fix 

Used to shift trajectories. Parametrical offset is adjusted to given parameters based on these 

equations: 

𝑥′ = 𝑥 + 𝑐𝑥0 + (𝑐𝑥𝑥 ∗ 𝑥) + (𝑐𝑥𝑦 ∗ 𝑦) 

𝑦’ = 𝑦 + 𝑐𝑦0 + (𝑐𝑦𝑥 ∗ 𝑥) + (𝑐𝑦𝑦 ∗ 𝑦) 
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Where (x, y) is the trajectory position and (x ’, y’) is the position after using this feature. 

 

Figure 58: Parametrical Offset Fix window 
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TRACKING LOG INFORMATION 

Shows table containing information about: 

Survey ID – File name. 

Date and Time – Here you can set the date 

and time the video was shot. 

Location – Here you can enter the location 

where the video was taken. 

Analysis Period Length – Sets the length of 

the period for which Vehicle Flow is 

calculated, e.g. at Traffic Analysis Gates and Origin-Destination Flow Graphs. 

Scene Type – Signalized intersection, Two-Way Stop-Controlled intersection, etc. 

Description – Here you can enter a description of the intersection or traffic situation.  

 

Figure 60: Tracking Log Information window 

 

 

  

 

Figure 59: Show Tracking Log Info 
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TRACKING LOG STATISTICS 

Displays a table containing information about Total 

number of tracks, numbers of individual types of 

objects and Other Statistics. 

 

 

 

 

 

Figure 62: Log Statistics window 

 

Figure 61: Log Statistics 
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ANALYSIS MENU 

A very important feature of SWISSTRAFFIC.ai Viewer is exporting Traffic Analysis:  

• Export Trajectories Movement Dynamics to CSV File 

• Export Gate Crossing Events to CSV File 

• Export Traffic Analysis to Excel File 

• Export Gap-Time/Time to Follow Data 

• Origin-Destination Statistics 

• Origin-Destination Flow Graphs 

• Calculate Headway Statistics 

 

Figure 63: Analysis Menu 
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ORIGIN-DESTINATION STATISTICS 

If you want to Export Origin-Destination Matrix click on the Analysis menu and select Show Origin-

Destination Statistics. 

 

Figure 64: Show Origin-Destination Statistics 

 

The Origin-Destination Statistic Matrix menu appears. Here you can set the required parameters for 

the exported Origin-Destination Matrix.  

• Check box "Whole video sequence” – By unchecking this option, you can select a specific part 

of the video by setting specific time or ID of image, and the statistics will only be made for that 

portion of the video. 

 

Figure 65: Video Range 

 

• On the Types menu, select the objects for which you want to perform statistics. 

And now the Statistics Matrix, here you can choose what data you want to export: 

• Vehicles count this option has additional sub-options:  

 

Normalisation Type:  

o Show Counts (no normalisation) – Only the numbers of objects passed from each 

Entry Gate to each Exit Gate are listed in the Matrix. 

o Divide by maximum value – The numbers in the Matrix indicate the ratio between the 

maximum number of objects and the number of objects that have passed through the 

given pair of Gates listed. 

o Divide by sum of values – The numbers in the Matrix indicate the ratio between the 

total number of objects and the number of objects that have passed through the pair 

of Gates listed. 
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These options have additional sub-options: 

▪ Across whole matrix – In this case, the ratio will be applied to the entire 

matrix. 

▪ For each Entry gate – In this case, the ratio will be relative to each Entry Gate 

separately. 

▪ For each Exit gate – In this case, the ratio will be relative to each Exit Gate 

separately. 

 

• Average Time – The average driving times from the Entry gate to the Exit gate will be entered 

in the matrix.  

The other times will be listed with other options like Minimal Time, Maximal Time, Median Time and 

Standard Deviation. 

 

Figure 66: Origin Destination Statistics Matrix 
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If you click on a field in the Origin-Destination Matrix that displays a specific route from the input to 

the output Gate, you will see a table that contains all the path parameters between these Gates 

(object counts, average times, etc.). You can scroll the table by clicking and dragging the left mouse 

button.  

 

Figure 67: Path Information 

 

You can also view multiple paths at once by pressing ctrl button and clicking on other paths. 

 

Figure 68: Multiple paths view 

 

Click the Export button to export to .csv format. This is a simple file format intended for table data 

exchange, for example, it can be run in Microsoft Excel.  

You can also create a snapshot of the current view by clicking the File menu and selecting Export 

Traffic Survey Snapshot or by pressing the P key on the keyboard. 
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ORIGIN-DESTINATION FLOW GRAPHS 

Flow Graphs are used to display the number of objects passed through the Gates over time.  

By default, the Flow Graph displays the total number of objects that passed between the Gates in the 

entire video sequence. In the Add O/D Flow Graph field you can mark a specific pair of Gates for which 

you want to generate a Flow Graph. Click on the appropriate field of the pair of Gates and then on the 

Add Graph to the Chart button to view the graph. You can remove the displayed graph by clicking on 

the Remove button or you can delete all displayed graphs by clicking on the Remove All Graphs 

button. 

In the Parameters field you can set:  

• Time window width [h:m:s] - Adjust the vertical axis sensitivity. 

• Reference Event - Based on what event the graph will be displayed. (Entry, Exit)  

• Graph Fill - Graph fill appearance.  

 

Figure 69: Origin-Destination Flow 
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You can also display a graph for multiple pairs of Gates at once. Press ctrl and click on the desired pair 

of Gates, then click Add Graph to the Chart. 

 

Figure 70: Origin-Destination Flow - Multiple Gates 
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CALCULATE HEADWAY STATISTICS 

This feature generates the Headway Statistics Report. The calculation is performed in the same way as 

for Traffic Analysis Gates, but in this case displays the summary values. 

Maximum headway time settings is used to filter too long 

time period between passed vehicles to get more accurate 

values. 

For individual Gate Passing Events you can view this statistic 

in Detailed Info of each Gate or Export Gate Crossing Events 

to CSV File. 

 

In the Headway Statistics Report you can find these 

values: 

Overall –Average Headway value. 

Sigma – The Standard Deviation of this value. 

Num of samples – Number of Gate Passing Events used 

for calculation. 

 

 

  

 
Figure 71: Maximum headway time 

 
Figure 72: Headway Statistics Report 
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SAFETY ANALYSIS 

Safety Analysis is used for creating a Conflict List which can be exported for further analysis and the 

detected conflicts are visualized in the scene view. You can find it in the Analysis Menu.  

 

Figure 73: Safety Analysis  

First it is necessary to set the Safety Analysis parameters, so click Safety Analysis. A window with two 

tabs will appear. In the Analysis Parameters tab, you can find: 

Video Range settings, by unchecking box Whole video sequence you can select a specific part of the 

video by setting specific time or ID of image, and the statistics will only be made for that portion of the 

video. 

In Types settings you can set for which object types the statistics will be calculated. 

In Simulation settings you can set Movement prediction model: 

• Speed Vector – This is a simpler calculation where the movement of the vehicle is considered 

straightforward. For this reason, the calculation of collisions in a curve is not entirely accurate, 

but the calculation is less demanding. 

• Ackerman Steer Model – This is a more precisely defined vehicle model, the calculation is 

based on the angle of the wheels, but for this reason the calculation is more demanding and 

takes more time. 

• Use Traffic Object Acceleration – By checking this box, not only the speed but also the 

acceleration of the vehicle are used in the calculation. 

Select Traffic Conflict Type: 

• Time To Collision –Calculates in how many seconds the vehicles would collide if they were 

moving at a constant speed and direction. Min. Speed Difference sets the minimum speed 

difference between two vehicles, if this difference is less than the specified value, the 

calculation will not be performed for this pair of vehicles. Threshold Value sets how many 

seconds the speed difference must be at least equal to the minimum value. The detected 

conflicts are visualized as arrows, which show the location and angle at which a collision would 

occur, rectangles indicate the position of vehicles. If you click on the marker of visualized 

conflict, the video sequence will set to the point when the conflict occurred. If there is any 
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conflict while playing the video, the alarm and the monitored value will be displayed over the 

vehicle. 

 

Figure 74: Safety Analysis – Time To Collision – selected and unselected conflict 

 

• Post Encroachment Time – Post-encroachment time is the difference between the time a 

vehicle enters a conflict point until the time another vehicle arrives to this point, Threshold 

Value filter data by maximum time. The detected conflicts are visualized as arrows, which 

show the location and angle at which a collision would occur. If you click on the marker of 

visualized conflict, the video sequence will set to the point when the conflict occurred. 

 

Figure 75: Safety Analysis – Post Encroachment Time – selected and unselected conflict 

 

• Heavy Braking – This is a detection of rapid deceleration, used to detect collisions or 

dangerous situations. Threshold Value sets how strongly the vehicle must brake to be included 

in the analysis. The detected conflict is visualized as a line that shows the path where the 

vehicle deceleration exceeded the threshold value. If you click on the marker of visualized 

conflict, the video sequence will set to the point when the conflict occurred. If there is any 

conflict while playing the video, the alarm and the monitored value will be displayed over the 

vehicle. 

 

Figure 76: Safety Analysis – Heavy Braking – selected and unselected conflict 
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In the Visualisation Parameters tab, you can set the appearance of the visualized conflicts: 

Conflict Font Size – When displaying a conflict, the value is displayed between vehicles, here you can 

set its font size. 

Conflict Line Width – Sets the line size of visualized conflicts. 

Trajectory Pair Line Width – Sets the line width between vehicles if there is a conflict where two 

vehicles interact.  

The Most / Least Critical Conflict Colour – Here you can set different colours according to the severity 

of the conflicts.  

 

 

Figure 77: Safety Analysis – Analysis and Visualisation Parameters 

 

After the Safety Analysis has been calculated, the Conflict List appears. Here you can find information 

about all detected conflicts, they are ranked from most critical to least critical. All detected conflicts 

are also visualised in the scene view. If you click on the marker of visualized conflict, the video 

sequence will set to the point when the conflict occurred, and the marked conflict appears in the 

Conflict List. 

Conflict ID –ID of the marked conflict.  

Conflict Type – Type of marked conflict. 

First Track ID – The first track ID related to the conflict. If you click Select! the track is highlighted in 

Selected Trajectory list. 
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Second Track ID – The second track ID related to the 

conflict. If you click Select! the track is highlighted in 

Selected Trajectory list. 

First Track Angle – Shows the angle of the first track at 

the time the conflict occurred. 

Second Track Angle – Displays the angle of the second 

track at the time the conflict occurred. 

 

Time Exposed TTC – Shows the amount of time the TTC 

value is below the threshold value. 

Time Integrated TTC – It is the area of the TTC below 

the threshold value. 

Worst Time to Collision – Shows the smallest Time to 

Collision of the conflict. 

TTC progression – If you click the Show button, you will 

see a graph of Time to Collision progress, horizontal axis 

is video time, vertical axis is Time to Collision. 

 

Post Encroachment Time – Shows the Post 

Encroachment Time for the conflict. 

 

Breaking Time – Shows how long the deceleration rate 

was higher than the set value. 

Deceleration Rate – Displays the maximum 

deceleration value for the conflict. 

 

Conflicts List – Here you can filter individual conflicts, check the box for the parameter and enter the 

searched value. 

  

 
Figure 78: Conflict List 
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You can set the display of detected conflicts in the View menu – Safety Analysis 

 

Figure 79: Selected Conflict 

 

Time Exposed TTC – Shows the amount of time the TTC value is below the threshold value. 

Time Integrated TTC – It is the area of the TTC below the threshold value. 

 

Figure 80: Time Exposed TTC and Time Integrated TTC explanation 
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NAVIGATING THE TIME AXIS – VIDEO MENU 

To move coarsely through the video sequence, a player-like slider is available at the bottom of main 

window. To its right, the current position is displayed – in terms of video frames (current Image 

ID/total Image IDs). If you click on Image ID you can switch between the current video time / total 

video length, video time relative to the time it was taken (you can set this time in Tracking log 

Information), and expired video milliseconds. 

 

Figure 81: Video Time 

The play/pause button functions similarly to a video/audio player. Playback speed is not real-time, as 

its speed is bound by several operations performed by Viewer on the video. Default speed of the video 

is defined By Frames, various playback speed options are also available – from 0,25x speed up to 8x 

speed. 

 

Figure 82: Time slider 

Here you can jump one second Forward / Backward in the video sequence or you can use the 

keyboard shortcut E to jump forward and Q to jump back. 

 

Figure 83: Jump Forward/Backward 

Or you can jump to the Start / End of the highlighted Track. 

 

Figure 84: Jump to the Start / End of track 
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You can also jump to the desired time or video frame by clicking on Jump in Video icon or you can use 

the keyboard shortcut Ctrl + J. 

 

Figure 85: Jump in Video 

 

After clicking on the Jump in Video icon you will see a table 

Jump in Video Sequence, here you can set the desired 

Frame, time, or millisecond of the video sequence. Click 

the Jump! button to perform the operation. 

 

 

 

You can also skip video Frame by Frame by clicking on the icons on the sides of the video slider or you 

can use the Left or Right arrow on the keyboard. 

 

Figure 87: Next / Previous frame 

 

Fine movement in time also can be performed by Navigating the Time Axis – Video Menu and 

associated keyboard shortcuts. 

 

Figure 88: Video Menu 

 

 

Figure 86: Jump in Video Sequence 
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There are also other options such as: 

• Reject image (shortcut Ctrl + G) – Selecting this 

option will delete the current video image, deleting 

the image does not affect the Trajectories. 

• Reject Range of Images... (Ctrl + Shift + G). After 

clicking on this option, the Reject Range of Images 

menu appears, here you can select the range of 

images you want to delete deleting the image does 

not affect the Trajectories. 

 

Show Information About Video – Opens new window with detailed information about the video: 

• Framerate 

• Video frame count 

• Frame range 

• Resolution 

• Camera information. 

 

 

 

 

 

 

 

 

 

 

  

 
Figure 89: Reject Image Range 

 
Figure 90: Video Information 
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SETTINGS MENU 

In this menu you will find Application Settings and Visualization Settings.  

 

APPLICATION SETTINGS 

Here you can Enable Video Buffering or Change Units Settings. 

 

Figure 91: Application Settings 

 

Enable Video Buffering 

Turn this setting on for better playback of a video sequence but it increases the computer's RAM 

memory usage. 

 

Units Settings 

Only in DRONE mode. Here you can set what 

units you want to use for:  

• Position – UTM / WGS-84 

• Length – meters / feet, 

• Speed – kilometres per hour / miles per 

hour 

• Acceleration – meters per second 

square / feet per second square 

 

  

 

Figure 92: Units settings 
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VISUALIZATION SETTINGS 

In this section you will find information about setting: 

• Scene Visualisation Settings 

• Rounding Properties Settings 

• Flag Dynamics Settings 

• Visibility Settings 

• Set Video Background Colour 

• Settings Presets 

• Quality 

 

Scene Visualisation Settings 

If you choose this option, the following window will 

appear. Here you can control the Font Size of the 

displayed values and Width of the Track, Flow, 

Distance or Gate lines. You can change the values in 

the fields by clicking the arrows or typing the desired 

value in the field. Confirm your changes by clicking 

the Save button. All changes to the visualization 

settings are shown in the corresponding image. If 

you want to restore the changes to their original 

state, click Reset to Defaults box.  

 

 

 

 

 

Trajectory Flag Font Size 

 

Figure 95: Trajectory Flag Font Size 

 

 

 

Figure 93: Scene Visualisation Settings… 

 

Figure 94: Scene Visualisation Settings window 
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Markup Label Font Size 

 

Figure 96: Gate Label Font Size 

 

Mark-up dynamic Font size 

 

Figure 97: Gate dynamic Font size 

 

Distance Measurements Font Size – Changes font size of distance between Position Flags. 

 

Figure 98: Distance Measurements Font Size 

 

Position Flag Font Size – Changes font size of Position Flags. 

 

Figure 99: Position Flag Font Size 

 

Selected Track Line Width 

 

Figure 100: Selected Track Line Width 
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Unselected Track Line Width 

 

Figure 101: Unselected Track Line Width 

 

Traffic Flow Min Line Width and Traffic Flow Max Line Width – Here you can set the minimum and 

maximum line width when viewing Origin-Destination statistics. The Max and Min line widths depend 

on the flow volume. 

 

Figure 102: Traffic Flow Min-Max Line Width 

 

Scene Caching (memory consuming) – Check this box to enable Scene Caching. 

 

Rounding Properties Settings  

Here you can set how many decimals the Speed or Acceleration of the object will be rounded. If you 

select the Object or Trajectory you can find both values in the Selected Trajectory table or you can 

display them in the scene view clicking the Show Target Speeds flag. 

Velocity / Acceleration Smooth Window Width specifies the time over which the speed will be 

calculated at that time, for example, the video is in time 00:05 (mm: ss), if you select a 1 second 

smooth window, the instantaneous speed will be calculated as the average of the values from 00:04 to 

00:06.  

You can change the values in the fields by clicking the arrows or typing the desired value in the field. 

Confirm your changes by clicking the Save button. If you want to restore the changes to their original 

state, click Reset to Defaults. 
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Figure 103: Rounding Properties Setting window 

 

Flag Dynamics Settings 

Here you can set the Track Flags behaviour dynamics. This setting is important for defining a stationary 

vehicle. Some vehicles that wait at the intersection do not stop completely but commute very slowly. 

Then they are not considered as stationary.  

• Max. Stationary Vehicle Speed [Km/h] – Sets at what speed the vehicle is still considered 

as stationary. 

• Min. Stationary Vehicle Spell [seconds] – Sets the minimum time the vehicle must stand 

to be considered as stationary. 

• Min. Time from the Last Gate [seconds] – Sets the minimum time that is displayed when 

the vehicle travels between two Traffic Analysis Gates. 

You can change the values in the fields by clicking the arrows or typing the desired value in the field. 

Confirm your changes by clicking the Save button. If you want to restore the changes to their original 

state, click Reset to Defaults box. 

 

Figure 104: Flag Dynamics Settings window 

 

Visibility Settings 

Types - This setting allows you to show or hide Trajectory and Info Flags of specific object types, click 

Overall Visibility to hide both. If you want to restore the changes to their original state, click Reset to 

Defaults box.  
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Figure 105: Visibility Settings window 

 

Gates - Here you can show or hide Tracks for specific Gates If you want to restore the changes to their 

original state, click Reset to Defaults box. 

 

Figure 106: Gates Visibility Settings 
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For example, if you set in View Menu Show Non-Present Track and check only one pair of Gates, you 

will see all the object Tracks between a specific pair of Gates. 

 

Figure 107: Gates Visibility Example 

 

Set Video Background Colour 

If a stabilized video is playing, or if the video display is turned off, it is the background colour below the 

video.  

 

Figure 108: Set Video Background Colour window 
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Settings Presets 

Here you can select the Preset Video Sequence quality.  

• HD Preset 

• FullHD Preset 

• 4K Preset 

• Custom Preset 

 

Quality 

Here you can set the Quality of the displayed video relative to the original video: 

sets the quality of: “Best” - same size, “Good” - original resolution scale 0.5, “Low” - original resolution 

scale 0.25, the resolution affects the quality and speed of video playback. 

• Best – The same quality as the original video. 

• Good – Half quality of the original resolution. 

• Low – Quarter quality of the original resolution. 
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VIEW MENU 

The main window view can be configured to a great extent, using the View menu items. 

You can find here:  

• Visualise Data Outside View 

• Show Text under Toolbar Icons 

• Show Unselected Tracks 

• Show Non - Present TracksShow Non - 

Present Tracks 

• Show Anonymization regions 

• Keep Anonymization regions up to date 

• Show Traffic Gates 

• Show Traffic Regions 

• Show Video 

• Manage Overlay… 

• Safety Analysis 

• Track Flags 

• Track Colouring 

• Switch Gate LabelSwitch Gate Label 

• Zoom 

• Switch Coordinate Space 

• Switch Scene Colouring 

 

 

Visualise Data Outside View 

Only for DRONE mode. Due to stabilization and georegistration, there are black corners in the video 

sequence. If you check this option, the Trajectories will be displayed in these black corners too. 

 

 

Figure 109: View menu 
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Figure 110: Visualise Data Outside View 

Show Text under Toolbar Icons 

Checking this box will display a description of the buttons on the Main toolbar.  

 

Figure 111: Text under Toolbar Icons 

 

Show Unselected Tracks 

If this box is checked (Default), only the Trajectories of the objects currently in the image are 

displayed, the button for this function is also located on the Main Toolbar.  

 

Figure 112: Show Unselected Tracks Button 
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Show Non - Present Tracks 

If this field is checked, all Trajectories in the video sequence are displayed.  

 

Figure 113: Show Non - Present Tracks 

 

Show Anonymization regions 

If this box is checked, it displays Anonymization regions, the button for this function is also located on 

the Main bar. (More about the Anonymization Regions)  

 

Figure 114: Show Anonymization regions 

 

Keep Anonymization regions up to date  

If this field is unchecked (Default), the Anonymization region field will not be refreshed and will display 

only the still image. If this field is checked, the Anonymization region field will be refreshed and will 

display a blurred image. (More about the Anonymization Region)  
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Show Traffic Gates 

Check this box to view the Traffic Gates, the button for this function is also located on the Main bar. 

(More about the Traffic Analysis Gates)  

 

Figure 115: Show Traffic Gates Button 

 

Show Traffic Regions 

Traffic Region is used to defining a stationary vehicle in a certain area in the scene view. 

 

Figure 116: Show Traffic Regions Button 

 

Show Video 

Check this box to show or hide the video sequence.  

 

Manage Overlay… 

Select this option to display the Overlay Visuals window. The button for this function is also located on 

the Main bar.  

 

Figure 117: Overlay Manager Button 

 

The Overlay Visuals setting is used to graphically display:  

Velocity – Absolute size of object velocity vector.  

Total Acceleration – Absolute size of immediate acceleration vector 

Tangential Acceleration – Only in DRONE mode. Positive value means acceleration and negative value 

means deceleration. 

Lateral Acceleration – Only in DRONE mode. Positive value means acceleration to the right and 

negative value means acceleration to the left. 
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Total Stationary Time – Visualizes areas where vehicles are considered stationary. For defining a 

stationary vehicle check Flag Dynamics Settings. 

Object Density – Visualizes the density of occurring objects. 

Safety Analysis – To view this overlay, you must first perform a Safety Analysis. Visualizes the conflict 

density of the selected type of Safety Analysis. 

Attention! Since there are no georegistered data in SCOUT mode, the velocity and acceleration values 

will be distorted due to perspective (distant objects move seemingly slower). Even though the speed in 

SCOUT mode is in kilo-pixels you can easily find out which parts of the roundabout the tracked objects 

pass at the highest speed.  

 

Figure 118: Overlay Visuals 

Overlay Generation Settings: 

• Overlay Type – Sets whether to display Velocity, Acceleration, Total Stationary Time, Object 

Density, Safety Analysis. 

• Overlay Mode – Sets whether to display Heat Map or Grid Map. 

• If you want to display the Legend check the Overlay Legend box. 
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• To select the object Types for which the Overlay is to be generated check required boxes in the 

Overlay Generation Settings. By default, the checkbox Select All is checked. 

• Roughness – Sets the density of the displayed points. 

• Dispersion – Sets the size of the displayed points.  

• Transparency Algorithm 

o Density – The transparency level is set according to the sample density for that point 

in the image. This means that where there is a higher density of values, the 

transparency is less, and with a lower density of values, the transparency increases 

o Presence – All samples in the heatmap are equal (in terms of transparency). This 

means that the same transparency value is set for greater and lesser density of values 

in the heatmap. 

• Then you can set if you want Overlay for Whole video sequence, Fixed interval or for Floating 

time window. 

All changes in Overlay Generation Settings must be confirmed by clicking the Update button or you 

can undo all changes by clicking the Reset to Default button. 

 

Figure 119: Overlay Visuals – Update 
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In Overlay Visualisation Settings you can find Generic Settings and Grid Map Settings. 

In Generic Settings you can set what Colour Map of displayed overlay you want, Transparency of 

displayed trajectories and Heat map value range, that allows you to change the sensitivity of the 

displayed overlay. 

 

Figure 120: Overlay Visualisation Settings 

 

If you select a Grid Map as the Overlay Mode, the Grid Map Settings become available:  

Warp perspective – Only in DRONE mode. Requires georegistration, sets the Grid Map projection to 

the Earth plane. 

Title size – Sets the size of each square of the map, by default in pixels. If checked Warp perspective, 

expressed in meters. 

Value type – Sets which value to display in squares (Average, Median, Minimum, Maximum). 

Show values – Sets whether to display values in squares. 

Clip to view – If some squares extend beyond the image, 

check this box to crop them according to the image size. 

Info font size – Sets the font size of the displayed 

information. 

 

 

 
Figure 121: Clip to view 



 

                                                                     V 1.0 / September 2020                                                                    74/99 

 

Figure 122: Overlay Visualisation Settings – Grid Map 
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Safety Analysis 

Here you can set whether to display detected conflicts in the scene view. In order to display conflicts, 

the Safety Analysis must be performed first, after the analysis the traffic conflicts and the traffic 

conflicts statistics are displayed automatically. Check Show traffic conflicts live to show or hide alert 

of detected conflicts. Check the Show traffic conflicts statistics box to display marks of detected 

conflicts. See more about Safety Analysis. 

 

Figure 123: Safety analysis 

 

Track Flags 

Flags are used for easier identification of objects and to display information about objects such as ID, 

type, speed, acceleration, colour, etc. They can be displayed using the Main toolbar or the View menu. 

If you click on the Flag of the tracked object, its Track will be highlighted and displays the following 

information in the Selected Trajectory list. 

 

Figure 124: Track Flags 
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Show Target IDs – Check this box to display Flags with the relevant object IDs, the flag of the selected 

object is orange. The button for this function is also located on the Main bar. 

 

Figure 125: Show Target IDs 

 

Show Target Speeds – Check this box to display the Flag with the Speed of the object. The button for 

this function is also located on the Main bar. 

 

Figure 126: Show Target Speeds 

 

Show Target Accelerations – Check this box to display the Flag with the Acceleration of the object. The 

button for this function is also located on the Main bar. 
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Figure 127: Show Target Accelerations 

 

Show Target Types – Check this box to display the Flag with the object Type. The button for this 

function is also located on the Main bar. 

 

Figure 128: Show Target Types 

 

Show Target Positions – Shows the current position of the object, in Units Settings you can change the 

coordinate system from UTM to WGS 84. 
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Figure 129: Show Target Positions 

 

Show Target Stationary Times – This function displays the stop time of the object. The button for this 

function is also located on the Main bar. For more accurate settings you can set the Max. Stationary 

Vehicle Speed and the Min. Stationary Vehicle Spell in Flag Dynamics Settings. 

 

Figure 130: Show Target Stationary Times 

 

Show Target Times from Last Gate – This function displays the time when the object last passed 

through the Gate. Traffic Analysis Gates must be inserted to display this value. The button for this 

function is also located on the Main bar. For more accurate settings you can set the Min. Time from 

the Last Gate in Flag Dynamics Settings. 

 

Figure 131: Show Target Times from Last Gate 
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Track Colouring 

You can set the track colour in the Track Colouring Approach menu, this menu allows you to change 

the colour of the track relative to the Type, Speed or Direction of the track. You can also check the 

option to Apply Colouring For Track Flags, after which the flags will be coloured according to the type 

or direction of the object. 

 

Figure 132: Track Colouring Approach 

Default Colouring – The Trajectory line is double coloured; green colour represents already travelled 

part of trajectory and blue colour represents the part of trajectory that is to be travelled. 

 

Figure 133: Trajectory line 

 

Type Colouring – Sets Track Colour according to object type. If you set this option, you will be given 

the option to set the track colour for each object type by clicking Select Track Colours for Types. 

 

Figure 134: Select Track Colours for Types 

 

Then appears a Track Colours by Object Type window where you can set the desired colours by object 

type. 
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Figure 135: Track Colours by Object Type 

 

Speed Colouring –If you select this option, you can set whether you want to Show Speed-Colouring 

Legend and also Set Range for Speed Colouring. 

Attention! Since there are no georegistered data in SCOUT mode, the velocity and acceleration values 

will be distorted due to perspective (distant objects move seemingly slower). 

 

Figure 136: Speed Colouring Options 

 

After clicking on the Set Range for Speed Colouring the Set Maximal Speed window appears, there 

you can set the highest speed at which objects move. Even though the speed is in kilo-pixels you can 

easily find out which parts of the roundabout the tracked objects pass at the highest speed.  



 

                                                                     V 1.0 / September 2020                                                                    81/99 

  

Figure 137: Set Maximal Speed 

 

Direction Colouring – If you select this setting, you can select the desired colour for each direction in 

the Set Track Colours for Directions setting. Gates must be inserted for this setting to function 

properly. 

 

Figure 138: Set Track Colours for Directions 

 

After clicking on Select Track Colours for Directions the Track Colours by Direction window appears, 

here you can choose colour for each pair of Gates or you can deselect different exit gates colors to 

display colors by entry gate only or different entry gates colors to display colors by exit gate only. 
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Figure 139: Track Colours by Direction 

 

Switch Gate Label 

This setting allows you to choose between displaying: 

• Gate Tags – Displays the Gate name. 

• Gate IDs – Displays the Gate identification number. 

• Gate Crossings – Displays the number of objects that have passed through the Gate. 

 

Figure 140: Switch Gate Label 

 

Zoom 

This setting allows you to Zoom In or Out of the scene view. To Switch to Detailed View Zoom you can 

use the Ctrl + Z shortcut and Ctrl + X to Switch to Overview Zoom.  
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Figure 141: Zoom menu 

 

If you click on Manage Views Zoom Levels…, the following window opens. You can set the zoom 

values for Overview Zoom Level and for Detailed zoom Level. If you click on the Current Level button 

you set the zoom value of the current view. 

 

  

Figure 142: Manage Views Zoom Levels 

 

You can also use the Mouse wheel to zoom in or out of the main image or you can set the desired 

zoom on the Main bar. 

 

Figure 143: Zoom Setting 

Switch Coordinate Space 

In DRONE mode, three spaces are defined by default:  

Show in Raw Coordinate Space – Input unstabilized video shot by camera. Since it is not a stabilized 

video, Trajectories must be recalculated for each frame, which is why Raw video playback is the most 

computationally demanding. 

Show in Reference Coordinate Space – Stabilized video. 

Show in Working Coordinate Space – A workspace that should display a bird's eye view. Playing video 

in this space is the least computationally demanding. 
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Figure 144: Switch Coordinate Space 

 

Switch Scene Colouring 

Here you can set whether the scene should be Coloured or Grayscale.  

 

Figure 145: Scene Colouring 
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DATA EXPORTING  

You can Export a number of useful information from SWISSTRAFFIC.ai Viewer, like Visualisation 

Videos, Visualisation Snapshots and Traffic Analysis in CSV, TRJ, DXF file or as an Excel file. 

 

EXPORT TRACKING LOG 

If you want to export the tracking log you can set these parameters: 

• Range Start Image ID and Range End Image ID – Sets the video range, the first and last frame 

of the video. 

• Generate Trimmed Video – If you want to export Tracking Log without video sequence check 

this box. 

• Export Anonymization Regions – If you want to export Anonymization Regions check this box. 

• Rotate Video and/or Workspace – After checking this box you can rotate Video or Workspace 

of exported log. 

 

  

Figure 147: Export Tracking Log Window 

  

 

Figure 146: Export Tracking Log Window 
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EXPORT TRAFFIC SURVEY VIDEO 

You can export a video using the Export Traffic Survey Video button located on main toolbar. 

 

Figure 148: Export Visualisation Video button 

 

Or you can use the File Menu and select Export Traffic Survey Video 

 

Figure 149: Export Visualisation Video… 

 

In both cases, the Export Traffic Survey Video window appears. Here you can Select the Output Path 

where you want to save the file and the file format of the exported video. You can also select a Preset 

video format (HD, FullHD, 4K, Custom) and embed a Logo, Info, or a Legend. 

• Embed Logo – If you want to display logo in video sequence check box Embed Logo. Then you 

can set Logo size relative to video image width and Logo position in the exported video. 

• Embed Info – Similar setting is for displaying information, here you can choose what 

information you want to display (Time, Location, Survey ID Scene Type), if you want to Add 

grey background for its better visibility and if you want to display all Info on one line.  

• Embed Legend – This setting is only available when a Legend is displayed, for example when 

using an Overlay. You can set here if you want to Embed Legend in, set Legend size relative to 

video image height, Legend position in the exported video, and if you want to Add grey 

background for its better visibility. 

• Skip rejected and unstabilised video-frames 

• Export rejected and unstabilised video frames as a black screen 

• Export whole video or just a part of it. If you want to export only a part of the video, you can 

set its length by the number of frames or by dragging the slider. 

• Export Area – whole scene, current view 

• Export Resolution – Sets the resolution of the exported image. 
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Figure 150: Export Traffic Survey Video window 
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By clicking on the Select path button the Save Visualisation Video window will be displayed, here you 

can choose the desired video format, the options are:  

• HuffYUV Lossless AVI video (*.avi) 

• RGB Lossless AVI video (*.avi) 

• FFMPE.G. Compressed AVI video (*.avi)  

• XVID Compressed AVI video (*.avi) 

  

Figure 151: Save Visualisation Video 

 

Then you can set the Export Area whether you want to export the whole scene or just the current 

view displayed on viewer. Then click the Export button, operation will take a few minutes. 
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EXPORT TRAFFIC SURVEY SNAPSHOT 

You can also create a snapshot of the current view by clicking the File Menu and selecting Export 

Traffic Survey Snapshot or by pressing the P key on the keyboard.  

 

Figure 152: Export Visualization Snapshot 

 

The Export Snapshot menu appears, Select Path where you want to save the snapshot, and then select 

the image quality Pre-sets (HD, Full HD, 4K, Custom).  

• Embed Logo – If you want to display logo in Snapshot check box Embed Logo. Then you can set 

Logo size relative to image width and Logo position in the exported image. 

• Embed Info – Similar setting is for displaying information, here you can choose what 

information you want to display (Time, Location, Survey ID Scene Type), if you want to Add 

grey background for its better visibility and if you want to display all Info on one line.  

• Embed Legend – This setting is only available when a Legend is displayed, for example when 

using an Overlay. You can set here if you want to Embed Legend in, set Legend size relative to 

image height, Legend position in the exported image, and if you want to Add grey background 

for its better visibility. 

Export Area – Whether you want to export the whole scene or just the current view. 

Export Resolution – Sets the resolution of the exported image. 

Then click the Export button. 
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Figure 153: Export Snapshot 
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EXPORT TRAJECTORIES TO CSV FILE  

If you want to Export Trajectories to CSV File you can use export button located on main toolbar. The 

exported CSV file contains only Trajectory data, e.g.: 

Track ID, Object Type, Entry Gate, Entry Time, Exit Gate, Exit Time, Travelled Distance, Average Speed, 

i.e. 

 

Figure 154: Export Trajectories to CSV File Button 

 

Or you can use the File menu and select Export Trajectories to CSV File. 

 

Figure 155: Export Trajectories to CSV File 

 

In both cases, the Export window appears, here you can set the Export Parameters: 

Export Trajectories – If you want to export Trajectories Check this box. 

Export only part of trajectories between entry and exit gates 

Export only current trajectory – Only the selected trajectory will be exported. 

Export only valid trajectories – Only trajectories that pass through the Entry and Exit Gate are 

considered valid. 

Export trajectories angles – Check this box if you want to export the vehicle angle for each exported 

position of Trajectory. 

Export trajectory traffic regions assignment – For each step, the information to which Traffic Region a 

given Trajectory belongs is exported, this can be used for further analysis, e.g. if you define Traffic 

Regions as a road lane you can detect when the vehicle has moved from lane to lane. 
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Exporting step in frames – sets the size of one step of exported trajectory positions, default is 1 frame, 

that is, the positions of each trajectory are exported for each frame, if you enter 2, the positions for 

every second frame will be exported etc. 

Entry Separator – Enter here which symbol you want to separate individual fields of the table. 

Decimal mark – Choose whether you want a decimal Dot or Comma in the exported document. 

Trajectory Time Origin – Specifies the video time: 

• Start of Video Sequence – Sets the start time to the start of the Video Sequence. 

• Start of Tracking Log – Sets the start time to the start of the Tracking Log, that means, the 

video capture time set in Tracking log Information will be used. 

• Start of Trajectory – Sets the start time to the start of the Trajectory.  

 

Figure 156: Export Trajectories to CSV File window 
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EXPORT TRAFFIC ANALYSIS  

One of the most important features of the SWISSTRAFFIC.ai Viewer is exporting the Traffic Analysis to 

CSV or Excel file; you can find this option in the Analysis menu.  

 

Figure 157: Analysis Menu 

 

EXPORT TRAJECTORIES MOVEMENT DYNAMICS TO CSV FILE 

Motion Dynamics contains the information about Track ID, Type, Entry Gate, Exit Gate, Gates 

Passed(list), Time Btw. Gates [s], Distance Btw. Gates [m], Time Total [s], Distance Total [m], Min. 

Speed Btw. Gates [km/h], Total Stationary Time [s], Longest Stationary Time [s], etc, for each 

trajectory. 

In Detailed Trajectory Info Export, you can Select the Output Path where you want to save the file. 

You can also set Separators and Decimal mark in Exported File.  

  

Figure 158: Export Trajectories Movement Dynamics to CSV File 
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EXPORT GATE CROSSING EVENTS TO CSV FILE  

Exporting Gate Crossing Events is similar to exporting Traffic Analysis Gates Detailed Info, but in this 

case, all Gates data is exported to a single file. When you select this option, the Export field is 

displayed. Here you can Select Output Path and Export Parameters that contain the settings of the 

Entry Separator used for CSV format and the Decimal Mark settings. 

  

Figure 159: Export Gates to CSV Data File 
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EXPORT TRAFFIC ANALYSIS TO EXCEL FILE  

In this file, you can find information about:  

• Survey overview and Overall statistics – This is the information you can find in Tracking log 

Information and Tracking Log Statistics.  

• Gate Statistics – Here you can find information about the number and speed of objects that 

have passed through the Traffic Analysis Gates. 

• Turning Movements – Here you can find information about Turning Movements for each 

object type. 

You can find this option in the Analysis menu. 

 

Figure 160: Export Traffic Analysis to Excel File 

 

Or you can find Export Traffic Analysis to Excel File button on the Main toolbar. 

 

Figure 161: Export Traffic Analysis to Excel File button 

 

Export Traffic Analysis to Excel File offers these options: 

• Whole video sequence – By unchecking this box, you can select a specific part of the video by 

setting specific time or ID of image, and the analysis will only be made for that portion of the 

video. 

• Turning Movements Analysis Periods – Division of analysis into sub-intervals into 3 categories: 

▪ Minor – This interval is defined by time, sets after what time the analysis will 

be performed. 

▪ Major – Intervals are defined by the number of Minor intervals, after the set 

number of Minor intervals has elapsed, the analysis is aggregated for the 

Major period. 

▪ Overall – intervals are defined by the number of Major intervals, after the set 

number of Major intervals has elapsed, the analysis is aggregated for the 

Overall period. 
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Figure 162: Export Traffic Analysis to Excel File window 
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EXPORT GAP-TIME/TIME-TO-FOLLOW DATA 

Available in DRONE mode only. Export Gap Time and Time to Follow Data can be found in the Analysis 

Menu. The traffic scene has to be properly annotated (see item Measurement Node – Gap Time and 

Time to Follow in Tracking Log Menu). 

First you need to set the Gap Time and Time to Follow parameters:  

Still speed threshold – In kilometres per hour. 

Vehicles moving bellow this threshold in the 

waiting lane are assumed to be still. 

Still time length threshold – In seconds. The 

vehicles must be still for at least this time for 

them to be assumed to be relevantly still. 

Vehicle crossroad join max distance - In metres. 

When the first waiting vehicle enters the 

crossroad, it is tracked for at least this number of 

metres. 

Vehicle crossroad join max time – In seconds. 

When the first waiting vehicle enters the 

crossroad, it is tracked for at least this number of 

seconds. 

Min time between same node blocking – In 

seconds. Minimal time of between the blocking 

of the same node by the same vehicle. This is 

used to deal with slight perturbation of data that 

can cause detection of multiple blocking events 

in short period of time even when the blocking 

vehicle passed beside the entry point only once. 

Assume only successful trajectories – If you 

check this box, only trajectories that fully passed 

the crossroad are assumed. 

Leading edge as reference – If you check this 

box, a centre of leading edge will be assumed as sensitive point for Gate passing detection. If false, the 

reference point is assumed. 

Max Tg time absolute – In seconds. If Tg is greater than this, the event is rejected. 

Max Tg time per vehicle – In seconds (per one vehicle that enters the blocking gap). If N waiting 

vehicles enters the crossroad, the Tg must be smaller or equal max Tg time per vehicle times N.  

Max Tf time – In seconds. If Tf is greater than this, the whole event is ignored. 

 
Figure 163: Tg and Tf parameters 

SWISSTRAFFIC.ai Viewer 
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Min number of left waiting vehicles – At least this many vehicles must be left out in the waiting lane 

after the event. Otherwise, the event is ignored. 

Max left waiting time diff – In seconds. Maximum time between the end of waiting of the last entered 

vehicle and start of waiting of the first left waiting vehicle. 

Min number of entered vehicles – At least this many vehicles must enter the crossroad for event to be 

included in the output. 

Max reaction time – In seconds. The maximum time window for the successive cars to fulfil reaction 

conditions after the previous car fulfilled its. Negative = the value is ignored (the check will not be 

applied). 

Min reaction speed – In kilometres per hour. If the speed of vehicle goes above this threshold, it is 

assumed that reaction happened. Ideally, this should be the same as still speed threshold.  

Min reaction acceleration – In metres per second per second. If the acceleration of the vehicle goes 

above this threshold, it is assumed that reaction happened. This and previous conditions are in OR 

relationship.  

Reaction time must be known – If this is true, only events that contains reaction points for every 

entered vehicle will be kept. 

Min blocking vehicle speed – In kilometres per hour. 

Blocking vehicle speed time range – In seconds. 

Max first waiting distance form gate – In metres. 

 

After setting the required parameters, click the Export button. 

 

Output description 

The output of post-process extraction of Gap Time and Time to Follow values is in a CSV (comma-

separated values) format, with one event per single line. A single event describes a situation when 

there was a gap in the main lane while there were waiting vehicles in the minor lane. It can cover two 

situations: 

1. The vehicles are waiting in the waiting lane, and two successive blocking vehicles passed in the 

main lane, forming a gap, that the waiting vehicles do not use - they will still be waiting to 

enter the crossroad. This can be identified by value entered_vehicles_count to be equal to 

zero. 

2. The vehicles are waiting in the waiting lane, and two successive blocking vehicles passed in the 

main lane, forming a gap, that the waiting vehicles (at least one) used. This can be identified by 

positive value entered_vehicles_count. 
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The data in the output file are formed into 12 mandatory columns, separated by semicolon: 

Unique Event ID – Unique identification number of the event. 

Measurement Node ID – Node ID at which the event happened. 

Waiting Gate ID – ID of the gate at which the event happened. 

Video Position of First Blocking [ms] – Video position (in milliseconds since the beginning of the video) 

when the first blocking vehicle of the gap in the main lane passed blocking gate. 

First Blocking Vehicle ID – ID of the first blocking vehicle. 

Second Blocking Vehicle ID – ID of the second blocking vehicle. 

Number of Waiting Vehicles – Number of vehicles waiting in the waiting queue when the gap 

happened. 

First Waiting Vehicle ID – ID of the first vehicle waiting in the waiting queue. 

Tg Value [ms] – Gap time value in milliseconds - difference between the times when the second and 

first blocking vehicles passed the Blocking Gate. 

Number of Left Waiting Vehicles – Number of waiting vehicles that were left out in the waiting queue. 

First Left Waiting Vehicle ID – If number_of_left_waiting_vehicles is positive, this contains the vehicle 

ID of the first vehicle that was left out in the waiting queue and not entered the crossroad. If 

number_of_left_waiting_vehicles is zero, this contains string “---” (without quotes). 

Entered Vehicles Count – Number of waiting vehicles that have entered the crossroad in the gap. 

If Entered Vehicles Count > 1 (i.e. multiple waiting vehicles entered the crossroad in that gap), the 

output line contains (entered_vehicles_count - 1) repetitions of additional 4 columns: 

Tf Value [ms] – Time to follow value of the next successive vehicle. 

Reaction Time [ms] – Reaction time of the successive vehicle. It is time when the successive vehicle 

reacted to the reaction of the vehicle in front of it. The reaction in this context is “starting the 

movement towards the entry of the crossroad” by either reaching reaction speed or acceleration. 

Following Entered Vehicle ID – Vehicle ID of the successive entered vehicle. 

Video Position of Following Vehicle Entry [ms] – Video position (in milliseconds since the beginning of 

the video) when the successive waiting vehicle entered the crossroad. 

These 4 columns are repeated for every successive waiting vehicle that have entered the crossroad 

(with exception of the first vehicle that entered the crossroad). 
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FREE DOWNLOAD!  

If you want to try SWISSTRAFFIC.ai Viewer, you can download it at the following link:  

 

http://SWISSTRAFFIC.ai./platform/software/ 

 

Try it! It's the ultimate solution for your Advanced traffic analysis. 

 

For more interesting information and features of our product, check out our main website: 

www.SWISSTRAFFIC.ai 

and make your solutions high, wishes you 
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